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Legal Information

The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and
site-specific development or schematic plan. It is not to be used for determining
suitability or reliability of the products/solutions for specific user applications. It is the
duty of any such user to perform or have any professional expert of its choice
(integrator, specifier or the like) perform the appropriate and comprehensive risk
analysis, evaluation and testing of the products/solutions with respect to the relevant
specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this document are the property of Schneider Electric SE or
its subsidiaries. All other brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and
provided for informative use only. No part of this document may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the
document or its content, except for a non-exclusive and personal license to consult it
on an "as is" basis.

Schneider Electric reserves the right to make changes or updates with respect to or in
the content of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is
assumed by Schneider Electric and its subsidiaries for any errors or omissions
in the informational content of this document, as well as any non-intended use
or misuse of the content thereof.

This document may contain standardized industry terms that may be deemed
inappropriate by our customers.
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Safety Information

Read these instructions carefully and examine the equipment to become familiar
with the device before attempting to install, operate, service, or maintain it. The
following special messages may appear throughout this user guide or on the
equipment to warn of hazards or to call attention to information that clarifies or
simplifies a procedure.

. The addition of either symbol to a “Danger” or “Warning”
A '\? safety label indicates that an electrical hazard exists which
will result in personal injury if the instructions are not
followed.

This is the safety alert symbol. It is used to alert you to
ifi personal injury hazards. Obey all safety messages that
follow this symbol to avoid possible injury or death.

A A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

AWARNING

WARNING indicates a hazardous situation which, if not avoided, could result
in death or serious injury.

ACAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result
in minor or moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

NOTE: Provides additional information to clarify or simplify a procedure.

Please Note

Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training
to recognize and avoid the hazards involved.

Electrical equipment should be transported, stored, installed, and operated only in
the environment for which it is designed.
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Proposition 65 Notice

WARNING: This product can expose you to chemicals including lead and lead compounds,
A which are known to the State of California to cause cancer and birth defects or other
reproductive harm. For more information go to www.P65Warnings.ca.gov.
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About the Book

Document Scope

The Quick Start Guide uses an application example to describe the different steps
to quickly install, configure and use TeSyse T.

This document is not intended to replace the following documents:
+ TeSys T LTM R DeviceNet Motor Management Controller User Manual
* TeSys T LTM R Instruction Sheet
* TeSys T LTM E Instruction Sheet

Validity Note

Schneider Electric assumes no responsibility for any detected errors that may
appear in this document. If you have any suggestions for improvements or
amendments or have found detected errors in this publication, please notify us.

No part of this document may be reproduced in any form or by any means,
electronic or mechanical, including photocopying, without express written
permission of Schneider Electric.

The data and illustrations found in this documentation are not binding. We reserve
the right to modify our products in line with our policy of continuous product
development. The information in this document is subject to change without notice
and should not be construed as a commitment by Schneider Electric.

Related Documents

Title of Documentation Reference Number
TeSys T LTM R DeviceNet This user manual introduces 1639504EN

Motor Management Controller | the complete TeSys T range

User Manual and describes the main

functions of the TeSys T LTMR
motor management controller.

TeSys T LTM Ree Instruction This document describes the AAV7709901
Sheet mounting and connection of
the TeSys T LTMR motor
management controller.

TeSys T LTM E-e- Instruction This document describes the AAV7950501
Sheet mounting and connection of

the TeSys T LTME expansion

module.
TeSys T LTMCU Control This manual describes how to 1639581EN
Operator Unit User Manual install, configure, and use the

TeSys T LTMCU Control

Operator Unit.

You can download these technical publications and other technical information
from our website at www.se.com/ww/en/download/.
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Quick Start Guide

Overview of the Application Example

Introduction

The Quick Start Guide uses an application example to illustrate each step in the
process of installing, configuring and using TeSys T.

The application example uses the LTM R controller to protect and control a motor
and its driven load, in this case, a pump.

This application example is intended to:

show you how to configure the LTM R controller in a few steps,
provide an example you can modify to develop your own configuration,

serve as a starting point for the development of more complex configurations,
incorporating such additional features as HMI or network control.

Functions Performed

When the LTM R controller has been configured in order to protect and control the
motor and pump, it will perform the following functions:

thermal overload protection

motor temperature sensor protection
voltage protection / undervoltage
external ground current trip protection

initial system configuration during commissioning using PC and SoMove
software

Operating Conditions

The operating conditions used in the application example are:

motor power: 4 kW

line-to-line voltage: 400 Vac
current: 9 A

control circuit voltage: 230 Vac
3-wire control

motor trip class 10

start button

stop button

reset button on enclosure door
trip light

alarm light

full voltage, non-reversing starter (direct over the line starter)

24 V/dc power supply in the motor control center or control station for future
use with LTM E expansion module inputs

1639575EN—-1
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Network Conditions

The network conditions for the example are:
» protocol: DeviceNet
* address: 1
* baud rate: Autobaud

The LTM R controller is configured via SoMove, not via the network (configuration
via network port is disabled).

The network software setup described in this document uses RSNetWorx
configuration software for network configuration and Studio 5000 for PLC
configuration.

Components Used

The application example uses the following components:

Item Component Description Reference Number
1 LTM R 100-240 Vac DeviceNet motor management controller (1.35...27 AFLC) LTMR27DFM

2 LTM E 100-240 Vac expansion module LTMEV40FM

3 LTM R to LTM E RJ45 connection cable LTMCCO004

4 USB to RS485 converter TCSMCNAM3MO002P
5 SoMove software version 2 2.3 SoMove

6 TeSys DTM Library v2.8 for TeSys T and TeSys U DTM Files

7 External ground current trip CT TA30

8 External PTC binary motor temperature sensor User supplied

Presentation of the TeSys T Motor Management System

System Overview

The TeSys T Motor Management System offers protection, control, and monitoring
capabilities for single-phase and 3-phase AC induction motors.

The system offers diagnostic and statistics functions and configurable alarms and
trips, allowing better prediction of component maintenance, and provides data to
continuously improve the entire system.

The 2 main hardware components of the system are:
* the LTM R controller, and
+ the LTM E expansion module.

System Presentation

The following tables describe the main components of the TeSys® T Motor
Management System.

1639575EN-1 9
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LTM R Controller

Functional Description

Reference Number

* current sensing 0.4...100 A

* single-phase or 3-phase current inputs

« 6 discrete logic inputs

e 4relay outputs: 3 SPST, 1 DPST

« connections for a ground current sensor

« connection for a motor temperature sensor

» connection for network

» connection for HMI device or expansion module
» current protection, metering and monitoring functions
* motor control functions

« power indicator

e trip and alarm LED indicators

* network communication and alarm indicators

¢ HMI communication LED indicator

« testand reset function

LTMRO08DBD (24 Vdc, 0.4...8 AFLC)

LTMR27DBD (24 Vdc, 1.35...27 A
FLC)

LTMR100DBD (24 Vdc, 5...100 A FLC)

LTMROSDFM (100...240 Vac, 0.4...8 A
FLC)

LTMR27DFM (100...240 Vac, 1.35...27
AFLC)

LTMR100DFM (100...240 Vac, 5...100
AFLC)

LTM E Expansion Module

Functional Description

Reference Number

* voltage sensing 110...690 Vac
* 3-phase voltage inputs
* 4 additional discrete logic inputs

+ additional voltage protection, metering and monitoring
functions

« power LED indicator
* logic input status LED indicators

Additional components required for an optional expansion
module:

* LTM R controller to LTM E connection cable

LTMEV40BD (24 Vdc logic inputs)

LTMEV40FM (100...240 Vac logic inputs)

Functional Description

Reference Number

» configure the system through menu entries
« display parameters, detected alarms and trips
« control the motor
Additional components required for SoMove software:
« aPC
* separate power source
*+  LTM R/LTM E to PC communication cable

SoMove 2 2.3

TCSMCNAM3MO002P
(USB to RS485 converter)

LTMCU Control Operator
Unit

Functional Description

Reference Number

» configure the system through menu entries
« display parameters, detected alarms and trips
«  control the motor

¢ LTMR/LTM E to HMI communication cable
¢ HMI to PC communication cable

LTMCU

LTMOCU30

(HMI communication cable)

Additional components required for an optional HMI device:

TCSMCNAM3MO002P
(USB to RS485 converter)

LTM9KCU
Kit for portable LTMCU

LTM R and LTM E Description

The following diagrams show the features of the LTM R controller and LTM E

expansion module:

10
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LTM R Controller

LTM E Expansion Module

(@) (5)
\‘ \

Ay T 4 1]
1000000000000 OOO0R
Al A2 11 C 1213 C 14 15 C |6 97 98 95 96
a Hdone ™ “ne b
@ LTMR100DBD ’%;
—_—
pag
@
e 1| 521
—t %: &
@ [ —)
[ — [ —1
— S Test /7 Reset > |
Hrno  nNo  nNo P Y P @
dl13 14 23 24 33 34 Z1 Z2 T1 T2 v+ CANH S CAML W
qOOOCCOCHOCOCIOOOO O
(1] 4 4 [11]

A f
&) @

1 Test / Reset button

2 HMI port with RJ45 connector connecting the LTM R controller to an HMI, PC, or LTM E
expansion module

3 Status-indicating LEDs

4 Plug-in terminal: control power, and internally powered logic inputs and commons
5 Plug-in terminal: double pole/single throw (DPST) output relay

6 Plug-in terminal output relay

7 Plug-in terminal: ground trip input and temperature sensor input

8 Plug-in terminal: PLC network

1 Port with RJ45 connector to HMI or PC

2 Port with RJ45 connector to LTM R controller

3 Status-indicating LEDs
4 Plug-in terminal: voltage inputs

5 Plug-in terminal: logic inputs and common

Installation

Overview

The following procedure describes how to install and physically configure the
TeSys T system, according to the operating conditions used in the application
example. The same procedure is used for other configurations.

The full installation procedure is shown on the Instruction sheets provided with the
LTM R controller and the LTM E expansion module. It is also described in detail in

the Installation chapter of the User Manual.

ADANGER

electrical work practises.

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
Turn off all power supplying this equipment before working on it.

Apply appropriate personal protective equipment (PPE) and follow safe

Failure to follow these instructions will result in death or serious injury.

The following diagrams show the physical dimensions of the LTM R controller and

the LTM E expansion module:

1639575EN-1
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LTMR LTME

MountLTM Rand LTME

Mount the LTM R controller and the LTM E expansion module, respecting
clearance zones and operating position.

The diagrams below show how to mount the LTM R and LTM E on a DIN rail, solid mounting plate, or Telequick plate:

This diagram shows the operating positions possible:

ans o
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ConnectLTMRtoLTME

Connect the LTM R controller and the LTM E expansion module using the RJ45
cable.

Connect to a TeSys T LTMCU HMI Device (Optional)

The diagrams below show the TeSys T LTMCU HMI device connected to the LTM
R controller, with and without the LTM E expansion module:

1 LTMCU Control Operator Unit
2 RJ45 cable (LTM9OCU30, in this example)
3 LTM R controller

4 L.TM E expansion module

Wire Current Transformers

Wire the current transformers according to the operating conditions:
* Productrange — 1.35...27 A
* Nominal motor current — 9 A

1 pass through the CT windows is sufficient in this case, although 2 passes are
possible:

A r
] = SEEIEEIEEEE | SEEE
oclhoooooooct oo

1639575EN-1
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Wire Ground Current Sensor

Wire the ground current trip transformer:

B
e —

Wire LTM R
» Wire the power supply and the 1/0.
» Wire the temperature sensors.
LOGIC INPUTS DESTRUCTION HAZARD
* Connect the LTM R controller's inputs using the 3 Common (C) terminals
connected to the A1 control voltage via an internal filter.
* Do not connect the Common (C) terminal to the A1 or A2 control voltage
inputs.
Failure to follow these instructions can result in equipment damage.
Wire LTME

The 4 logic inputs on the LTM E expansion module (1.7 - 1.10) are not powered by
the control voltage of the LTM R controller.

Wire the voltage transformers and the 1/0 on the LTM E expansion module.

Use of AC Interposing Relays

The use of an AC interposing relay is allowed only on short distances if an AC
voltage is mandatory.

AC RSB1 relay voltage 24 VAC 48 VAC 120 VAC 230/240 VAC
Maximum distance for wires in parallel without 3,000 m (10,000 1,650 m (5,500 ft) | 170 m (550 ft) 50 m (165 ft)
metallic screening ft)

Maximum distance for wires in parallel with 2,620 m (8,600 ft) | 930 m (3,000 ft) 96 m (315 ft) 30 m (100 ft)
metallic screening

14 1639575EN—-1
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Use of AC Interposing Relays with a Rectifier

The following diagram shows an example when using AC interposing relays:

The use of AC interposing relay with a rectifier is recommended on long distances

if an AC voltage is mandatory.

Add a rectifier composed of 1 A/ 1000 V diodes to command an AC interposing
relay. In this way, rectified AC current flows in the control cable when the switch in

the continuous part is closed.

AC RSBH1 relay voltage

24 VAC

48 VAC

120 VAC

230/240 VAC

metallic screening

Maximum distance for wires in parallel without

3,000 m (10,000
ft)

3,000 m (10,000
ft)

3,000 m (10,000
ft)

3,000 m (10,000
ft)

metallic screening

Maximum distance for wires in parallel with

3,000 m (10,000
ft)

3,000 m (10,000
ft)

3,000 m (10,000
ft)

3,000 m (10,000
t)

The following diagram shows an example when using AC interposing relays with a

rectifier:
EA\l TL 1
&
~ % .
[]
A1 A2 N

1639575EN-1
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LTM R Controller Wiring

The diagram below illustrates the main power circuit and the 3-wire (impulse) local control with network control
selectable, corresponding to the application example.

1 Contactor

2 Ground current trip transformer
3 PTC binary thermistor

4 Detected alarm indication

5 Detected trip indication

L Local control

O Off

N Network control

Configuration

Overview

After the wiring connections are made, the next step is to configure parameters
using SoMove software (see the SoMove chapter of the User Manual for more
details).

16 1639575EN—-1
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AWARNING

UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and
programming of control systems. Only persons with such expertise should be
allowed to program and apply this product.

Follow all local and national safety codes and standards.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Connect to SoMove™ Software

In the application example:

1 PC running SoMove software

2 USB to RS485 converter TCSMCNAM3MO002P
3 LTM R controller

4 LTM E expansion module

If you are not using the expansion module, the HMI connects directly
to the controller:

2 USB to RS485 converter TCSMCNAM3MO002P
3 LTM R controller

Set Parameters

of the window.

Step Action Result
1 Start the SoMove software. -
2 In the Main screen, select the Edit Connections button on the | The Scan Result dialog box opens.
left side.
3 Select the Advanced Settings button in the upper-right corner | The Advanced Settings dialog box opens.

settings:
+ Connection-Type: Serial Line

RS485 converter is connected.

4 In the Advanced Settings dialogue box, make the following

* COM Port: Must be set to the Com port that the USBto | || o

NOTE: You can check this in Windows Control
Panel > Device Manager and then expanding
Ports. The USB to RS485 Converter will be labeled
as TSX C USB 485 (COM##)

* Link parameters: The Auto-Adaptation box should be
checked.

1639575EN-1
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Step Action Result
5 Confirm the selected setting and click OK. The Scan Result dialog box appears.
6 In the Scan Result dialog box, select the Scan Network The TeSys T unit will appear in the blank space above the
button. Scan Network button.
NOTE: The SoMove software will search for any TeSys T
that is connected through the USB to RS485 converter
cable.
7 Once the TeSys T unit appears, click Apply. The Main screen appears.
8 Select the Create a Project OFF-line button. The Select a Device dialog box opens.
9 In the Select a Device dialog box, make the following
selections:
* Selectthe TeSys T icon
» Select Communication: Modbus Serial
[Upsse | Select Communication wamees = S
10 Confirm the selected settings and click Next. The Create Topology dialog box opens.
11 In the Create Topology dialog box, select the controller,
controller firmware version, expansion module, and expansion | [ ——————
module firmware version. For this example, the following i
settings were selected. ] ==
* Controller commercial reference: LTMR27DFM .,,,:: mmmmmm
« Controller firmware version: v2.7 R
+ Expasion module commercial reference: LTMEV40FM e
* Expansion module firmware version: v1.8 —
o ] (e
12 Confirm the selected setting and click Create. The SoMove project landing page opens.
13 Select the parameter list tab to set up the TeSys T device. The | —
example application parameters are set up per List of
Parameter Settings, page 18.
14 Select File > Save to save the configuration file. The Save As dialog box opens.
15 Enter a relevant name and click Save. -

List of Parameter Settings

Parameter settings for the application example:

Device Information Sub-branch Parameter Setting

Branch

Device information - Current range 1.35-27 A
Network DeviceNet
Control voltage 100-240 Vac

18
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Settings Branch Sub-branch Parameter Setting
Motor and Control Settings | Motor operating mode Nominal voltage 400 V
Nominal power 4 kW

Operating mode

3 wire independent

Contactor rating 9A
Phase 3 phase
Motor temperature sensor Sensor type PTC binary
Trip enable Enable
Trip level According to motor
Alarm level According to motor
Load CT Load CT ratio Internal
Load CT passes 1(1)
Ground Current Sensor Ground Current Sensor 1000:1
ratio
Control mode Local control Terminal trip

Thermal Settings Thermal overload Trip type Inverse thermal
Trip class 10
FLC1 () 50 %) (equivalent to 9 A)
Trip enable Enable
Alarm enable Enable
Current Settings Ground Current Mode Trip enable Enable
Trip level 1A
Trip timeout 05s
Alarm enable Enable
Alarm level 200 mA
Voltage Settings Undervoltage Trip enable Enable
Trip level 85 %
Trip timeout 3s
Alarm enable Enable
Alarm level 90 %

Transfer the Configuration File

(1) SeeFLC (Full Load Current) Settings, page 20

Step Action

Result

1 Select File > Open Project and then navigate to the required location and
select the configuration file.

2 Once the project file is loaded, select Communication > Connect.

The Connect dialog box opens.

]

1%

Store to device Load from device
and Connect and Connect

1639575EN-1
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Step Action Result

3 Select Store to Device and Connect. The SoMove software connects to the TeSys T

and the Danger dialog box appears.
A DANGER

4 Read the alarm on the Danger screen and follow the instructions to accept. The SoMove software loads the current
settings from the TeSys T and displays the
landing page.

5 The SoMove software downloads the configuration file and displays the Store

to Device dialog box when complete. T De\r———’ ——
0/ Store to device is Successful.

6 Select OK to go online with the device. The SoMove will confirm that it is connected
and it is indicated at the bottom-left corner of
the landing page.

&% connected | €Y %0 ‘ ‘ ‘ Q";‘utrip ‘

7 The product is now ready to use. -

FLC (Full Load Current) Settings

FLC Basics

NOTE: Before setting the FLC, you must first set the Contactor rating and

Load CT ratio.

* Load CT ratio = Load CT primary / (Load CT secondary * Passes)

» Current sensor max = Current range max * Load CT ratio

* Current range max is determined by the LTM R controller commercial
reference. It is stored in units of 0.1 A and has one of the following values:

8.0, 27.0, or 100.0 A.

» Contactor rating is stored in units of 0.1 A and is set by the user between 1.0

and 1000.0 A.

«  FLCmax is defined as the lower of the Current sensor max and the Contactor

rating values.

*  FLCmin = Current sensor max / 20 (rounded to the nearest 0.01 A.). FLCmin

is stored internally in units of 0.01 A.

NOTE: Do not set the FLC below the FLCmin.

Conversion of Amperes to FLC Settings

FLC values are stored as a percentage of FLCmax

FLC (in %) = FLC (in A) / FLCmax

20
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NOTE: FLC values must be expressed as a percentage of FLCmax
(resolution of 1 %). If you enter an unauthorized value, the LTM R will round it
up to the nearest authorized value. For example, on a 0.4-8 A unit, the step
between FLCs is 0.08 A. If you try to set an FLC of 0.43 A, the LTM R will
round itupto 0.4 A.

Example (No External CTs)

Data:

FLC (inA)=9A

Current range max = 27.0 A
Load CT primary = 1

Load CT secondary =1
Passes = 1or 2

Contactor rating=18.0 A

Calculated parameters with 1 pass:

Load CT ratio = Load CT primary / (Load CT secondary * passes)=1/(1*1)
=1.0

Current sensor max = Current range max * Load CT ratio =27.0 *1.0 = 27.0
A

FLCmax = min (Current sensor max, Contactor rating) = min (27.0, 18.0) =
18.0A

FLCmin = Current sensor max/20=27.0/20=1.35A
FLC (in %) =FLC (in A)/ FLCmax =9.0/18.0 =50 %

Calculated parameters with 2 passes:

Diagnostic

Load CTratio=1/(1*2)=0.5

Current sensor max =27.0*0.5=13.5A

FLCmax = min (13.5, 18.0)=13.5A

FLCmin = Current sensor max /20 =13.5/20 =0.67 A
FLC (in %) =FLC (in A)/ FLCmax =9.0/13.5=66 %

LTM R and LTM E LEDs

As the application example uses the LTM R and LTM E, you must check the LEDs
on both components:

1639575EN-1
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LEDs

Use the 5 LEDs on the face of the LTM R controller to monitor its state, as follows:

LTM R LEDs Color Describes Indicates
HMI Comm Yellow Communication activity between »  Flashing yellow = communication
LTMR (_:ontroller and LTME «  Off = no communication
expansion module
Power Green LTM R controller power or internal » Solid green = power on, no internal trips, and motor off
trip condition « Flashing green = power on, no internal trips, and motor
on
«  Off = power off, or internal trips exist.
Alarm Red Protection trip or alarm, or internal « Solid red = internal or protection trip
trip condition * Flashing red (2 x per second) = alarm
« Flashing red (5 x per second) = load shed or rapid cycle
condition
« Off =no trips, alarms, load shed or rapid cycle (when
power is On)
Fallback Red Communication connection « Solid red = in fallback
between LTM R controller and - Off = notin fallback (no power)
network module
MNS Yellow Communication activity on the »  Flashing yellow (0.2 s on,1.0 s off) = network bus
network bus communication
»  Off = no network bus communication
Use the 5 LEDs on the face of the LTM E expansion module to monitor its state:
LTM E LEDs Color Describes Indicates
Power Greenor | Module power or internal trip » Solid green = power on with no internal trips
red condition . _ P :
« Solid red = power on with internal trips
*  Off = power off
Digital Inputs 1.7, 1.8, Yellow State of input *  On =input activated
.9.and I.10 «  Off = input not activated

Use with TeSys T LTMCU Control Operator Unit

Available Functions

Once connected to the LTM R, the LTMCU can be used to:
» configure parameters for the LTM R controller,

+ display information about the LTM R controller configuration and operation,

* monitor trips and alarms generated by the controller,

» control the motor locally using the local control interface.

22
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LTM CU Front Face

Navigation Keys

The LTMCU front face is shown below:

@

Y

@

OO0

1 LCD display

2 Contextual navigation keys

3 Front face RJ45 port for PC connection (covered)

4 Local control interface, including 5 control keys and 4 LEDs

The LTMCU navigation keys are contextual, that is, their function depends on the
associated icons shown on the LCD display. These icons change for different
displays, so the navigation key functions also change.

The navigation keys can be used to:

navigate menus and sub-menus,

scroll within a value list,

select a setting in a value list,

exit a value list without making a selection,
return to the main (first-level) menu,

switch between manual and automatic presentation mode in Quick View
display.

1639575EN-1
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The diagram below shows an example of the different functions of each of the
navigation keys associated with an icon on the LCD display:

Metering setting

™\

\ Load CT

t v K

A

A

(O

vee oo

1 Information area of the LCD display

2 Contextual navigation icons area of the LCD display

3 Move up to the next higher-level menu

4 Move down to the next item in the menu

5 Select an item

6 Move up to the previous item in the menu

7 Return to the main menu

LCD Displays

The LTMCU presents 3 different LCD displays:

LCD display Functionality
Menu Displaying and editing the configuration settings required for configuring the LTM R (metering,
protection, control and services settings)
Displaying diagnostic and history data
Quick View » Displaying real-time metering of pre-selected parameters by automatic or manual scrolling
Detected Trips and Alarms Displaying the most recent detected trip or alarm

Contextual Navigation Icons

The following table describes the icons used with the contextual navigation

buttons on the LTMCU:

Icon

Description

Icon

Description

Enables access to the main menu from a sub-menu or
from Quick View

>

Enables access to Quick View from the main menu or a
sub-menu

Scroll down

€

Enables access to manual scroll mode (when Quick
View is in automatic scroll mode)

24
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Icon

Description

Icon

Description

Scroll up

Enables access to automatic scroll mode (when Quick
View is in manual scroll mode)

OK

Validates a setting or value and enables access to a
sub-menu when a menu is selected

+ | [Q

Used to increment a setting in menu mode

Move up to the next higher-level menu

Used to decrement a setting in menu mode

i

When a menu item is password-protected, this icon
enables access to the Enter Password screen

Information Icons

The following table describes the icons provided as information in the information
area of the LCD display. They indicate, among others, the selected menu or

parameter:

Icon

Description

Icon

Description

E>

Main menu

Indicates that the present display is Quick View

Metering setting menu

Indicates that a detected alarm has occurred

F

Protection setting menu

Indicates that a detected error has been detected

Control setting menu

Information

Services menu

NS HENENIC

Check box selected

Language selection menu

Check box unselected

Radio button selected

<

Iltem has been selected (for inclusion in Quick View
display)

Of 1@ | [T | |&] | ==

Radio button unselected

LTM R in Configuration mode

1639575EN-1
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Example of an HMI Display

Here is an example of HMI LCD displaying an average current of 0.39 A in local
control, run mode:

P ¢ ¢
Avg Cu‘rrent RuFl

- 039 A

I

1 Quick View display icon

2 Name of the setting currently displayed
3 Motor state
4 Short cut key to main menu

5 Manual scroll mode icon; pressing the associated contextual navigation key
switches to manual scroll mode

6 Value of the setting currently displayed

Network Communication on DeviceNet™

Wire the Communication Port

This procedure is shown on the Instruction sheets provided with the LTM R and
the LTM E, and described in the Installation chapter of the User Manual:

LTM ReseDes DeviceMet

4
__,/j

'/T:'JI—.' Rieset

ll.lh T1 T |WeCANH S CANL Ve
i NN

_ — I

(1) Thin cable
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Set the Parameters

For the application example, set the following parameters using SoMove™

software:
Settings Branch Sub-branch Parameter Setting
Device information - Network DeviceNet™
Communication Network port Address 1
Baud Rate Autobaud
Configuration via Network port Disabled

Messaging

Communication Architecture

You can set Baud Rate to Autobaud only if at least 1 secondary is configured with

a specific Baud Rate.

Network Port Comm Loss parameter is enabled by default. If this is not suitable,

you can disable this parameter.

The connection types are:

* 1/0 messaging
I/O messages contain application-specific data. They are communicated

across single and multicast connections between an application producer and
its corresponding consuming application.

« Explicit messaging connections

Explicit messaging connections provide multipurpose point-to-point
communication paths between two particular devices. Explicit messages are

used to command the performance of a particular task and to report the

results of performing the task. Use explicit messaging connections to

configure nodes and diagnose conditions.

1639575EN-1
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1 1756-A7 Allen-Bradley ControlLogix chassis with 7 slots

2 1756-PA72 Allen-Bradley ControlLogix power supply 120-240 Vac
3 1756-L71 Allen-Bradley ControlLogix controller, revision 24

4 1756-DNB Allen-Bradley ControlLogix DeviceNet™ scanner

5 LTMR27DFM LTM R controller communicating over DeviceNet™

6 LTMEV40FM LTM E Expansion module

7 Power tap

8 Power supply (24 Vdc)

Software Tools

Reference Number Freeware Description

9357-DNETL3

- RSNetWorx for DeviceNet™ application for configuring and
monitoring DeviceNet™ networks and configuring connected
devices.

9324-RLD300ENE - RSLogix Designer configuring and programming software for

the Allen-Bradley Logix5000 family of controller.

TeSys TMMC L A TeSys® T Motor Management Controller system without an
expansion module, configurable via the HMI port. This variant
enables you to preserve your local configuration.

TeSys T MMC L EV40 A TeSys® T Motor Management Controller system with
expansion module, configurable via the HMI port. This variant
enables you to preserve your local configuration.

TeSys TMMC R A TeSys® T Motor Management Controller system without
expansion module configurable via the network.

TeSys T MMC R EV40 A TeSys® T Motor Management Controller system with
expansion module configurable via the network.

Assemble the Physical Network

To construct a physical DeviceNet™ network:

Step Action
1 Install the DeviceNet scanner module in the desired PLC slot.
2 Check that the desired DeviceNet network node address and baud rate have been correctly set in SoMove.
3 Make connections with DeviceNet™ network cable and end connectors, manufactured in accordance with ODVA
specifications.
4 Place the system on the network by connecting the PLC to the LTM R controller with the DeviceNet™ cable.
5 Connect the RSNetWorx PC to the processor.

Software Network Configuration

To configure the DeviceNet™ network:

28
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Step Action Comment
1 Register the Controller’s EDS, page 29 Action in RSNetWorx.
2 Offline Controller Configuration, page 29
3 Scanner Configuration, page 32
4 PLC Configuration in Studio 5000, page 33 Action in Studio 5000.
5 DeviceNet Communication Test, page 35

Register the Controller’s EDS

To register the controller’s EDS in RSNetWorx’s EDS library:

Step Action Result
1 From the RSNetWorx Tools menu, The wizard’s welcome screen appears.
select EDS Wizard.
2 Click Next. The Options screen appears.
3 Select Register an EDS file(s) and The Registration screen appears.
click Next.
4 Select Register a directory of EDS -
files and browse to the controller’s
EDS file.
NOTE: You must have already
unzipped the zip file containing
the EDS files and corresponding
icons into a single directory.
5 Click Next. The EDS File Installation Test Results screen appears.
6 Click Next. The Change Graphic Image screen appears. The controller should be listed in
the Product Types field as a Motor Starter.
Rockwell Automation’s EDS Wizard u‘
Chi‘.(r:)guecgr?r?:r:;elng;eaphm image thatis associated with a device.
Product Types
Change icon =l Motor Starter
i TeSysT MMC V02.01L
i TeSysT MMC V02.01 L EV40
i TeSysTMMC V0201 R
i TeSysT MMC V02.01 REV40
|
I
l <Back Next> cancel |
| I _
7 Click Next. The Final Task Summary screen appears.
8 Verify that the controller is to be The Completion screen appears.
registered and click Next.

Offline Controller Configuration

To add devices to your network when the configuration tool is offline:
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Step

Action

Result

1

From the hardware list, double-click
on 1756-DNB Major Rev 12 under
Rockwell Automation/
communication adapter.

The scanner appears in the Project view with address 0.

B oot et e
BRI

@QlE 1%~ &4 B &

File Edit View Network Device Diagnostics Tools Help

5 1756-DNB

@) 1738-ADN12 ArmorPoint DeviceNet Adar
@) 1738-ADN12 ArmorPoint Scanner g

1) 1738-ADN18 ArmorPoint DeviceNet Adap
) 1738-ADN18 ArmorPoint Scanner
EJ 1738-ADN18P ArmorPoint DeviceNet Adz _ 00
EJ 1738-ADN18P ArmorPoint Scanner I
) 1738-ADNX ArmorPoint DeviceNet Adapi
-8 1738-ADNX ArmorPoint Scanner 7
# 1747-SDN Scanner Module
=-§ 1756-DNB
8
] Major Rev 11
§ Major Rev 10
i Major Rev 07
§ Major Rev 06
g Major Rev 05
§ Major Rev 04
§ Major Rev 03
§ Major Rev 02
] Major Rev 01
B 1761-NET-DNI Device Net Interface
8 1761 -NFT’-':')NI Series B nF‘Vil"PNPf‘ lntsrf}al ad

M|« > M7\ Graph [ Spr

<

x|

From the hardware list, double-click
on the controller EDS named TeSys T
MMC V02.01 L EV40 under
Schneider Automation, Inc.\Motor
Starter.

The new device appears in the Project view. The lowest available MAC ID has

been assigned to it, even if that ID is inappropriate.

H§ *DeviceNet - RSNetWorx for DeviceNet SN I 0
IEIEAC I
@@l =% - &4 |6

Hfile Edit View Network Device Diagnostics Tools Help

'l [EENE TeSysT
4 Safety Analog /O Device B MMC

+-) Safety Controllers N
+-) Safety Discrete 1/O Device i
5@ Smart MCC 0
) @ Softstart Starter 00 01
1) Software Configured Safety Relay
7@ Specialty I/O
- Vendor
1 Benshaw Inc.
7-© Electro-Craft
7€) Rockwell Automation / Dodge
) @ Rockwell Automation/Allen-Bradley
1) Rockwell Automation/Entek IRD Intl.
1@ Rockwell Automation/Reliance Electric
13- Rockwell Automation/Sprecher+Schuh
- Schneider Electric
&-@ Motor Starter

W TeSysT MMC V0201 L

W TeSysT MMC V02.01 L EV40

¥ TeSysT MMC V02.01 R

¥ TeSysT MMC V02.01 R EV40

11

< (1 ) »

Il IR \Gmph { Spreadshee

Double-click on the controller graphic.

The controller’s properties window appears.
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Step Action Result

4 Change the MAC ID in the Address 1 is the MAC ID used throughout this example.
text field to match the address set in

the TeSys T. (& resysrmmcvozorLeva L o]

General | Parameters | 1/0 Data | EDS File |

i TeSysT MMC V02.01 LEV40

Name: eSysT MMC V02.01 L EV40|

Description:

Address: 1 3:

Device Identity [ Primary ]

Vendor: [Schneider Electric [243]

Type: |Mnluv Starter [22]

Device: ITESysT MMCV02.01 L EV40 [305]

Catalog: ILTM1

Revision 1.007 LI LI

OK | Cancel | Appl: I Help I

5 Click Parameters tab to select the For our example, select the following two instances:

data you want to exchange (Instance) * Input assembly data size (produced by the controller)
NOTE: Check the Groups box. 110 - LTM R Monitoring Registers (with dynamic configuration)

Instance length = 8 bytes

Select register 455 (System status), 460 (Alarm code), 451 (Trip code), 466
(Average current ratio (%FLC).

* Output assembly data size (consumed by the controller)
100 - LTM R Control Registers
Instance length = 6 bytes

B TesysT MMC V0201 L EV40 (B

General Parameters | /0 Data | EDS File |

Selectthe parameter that you want to configure and initiate an action
‘.4 using the toolbar.

[ Groups B @ lm = Monitor E W
D @ ﬂ F Current Value &
(& Control Supervisor Object
B Overload Object
@ DeviceNet Object
‘@ DeviceNet interface =
61 PollProdPath 110-LTM1 Monitoril
62 PollConsPath 100-LTM1 control re
63 CCProdPath 110-LTM1 Monitoril
64 Autobaud Autobaud enable
65 LTM1 monitoring - Word 0 455
66 LTM1 monitoring - Word 1 460
67 LTM1 monitoring - Word 2 451
68 LTM1 monitoring - Word 3 466
(3 Area of identification
(A Aroa nf ictir tntale N
< 1l | »

ok | cancel Apply | Help
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Step

Action

Result

6

Click OK.

B e e o Dencene 1
|8 ®~-d|(& s B2a|x

@allEE®- &4 @@

File Edit View Network Device Diagnostics Tools Help

| = 1756-DNB  TeSysT

© safety Analog 1/0 Device -
© safety Controllers
© safety Discrete /O Device é i
© Smart MCC 0
© Softstart Starter 00 01
© Software Configured Safety Relay
© Specialty /O
=-© Vendor
© Benshaw Inc.
© Electro-Craft
© Rockwell Automation / Dodge
© Rockwell Automation/Allen-Bradley
© Rockwell Automation/Entek IRD Intl.
© Rockwell Automation/Reliance Electric
© Rockwell Automation/Sprecher+Schuh
&-@ Schneider Electric
=@ Motor Starter
W TeSysT MMC V02,01 L
W TeSysT MMC V02,01 L EV40
¥ TeSysT MMC V0201 R
W TeSysT MMC V02,01 R EV40

< m » W/ 4| »| M )\Graph { Spreadshest }

-

i

From the RSNetWorx Tool menu,
select Online.

The Browse for Network screen appears.

Click OK.

A notice appears on the screen which notifies you to upload or download

configuration to the network.

Before the software allows you to configure online devices, you
must upload or download device information. When the upload
or download operation is completed, your offline configuration
will be synchronized with the online network.

‘ Note: You can upload or download device information on either
a network-wide or individual device basis.

Right-click and select Download to
device.

Configuration is downloaded to the device.

Scanner Configuration

Step Action Result
1 From the Project view, double-click the The scanner configuration screen appears.
scanner icon.
2 Select the Scanlist tab. The Scanner Configuration Applet screen appears.

32
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Step Action

Result

3 At the Scanlist tab, highlight the controller
(at MAC ID 1) in the Available Devices
list, and click the right arrow.

The controller now appears in the Scanlist.

Geneval] Module Scanlist |Inpul I Outpull ADR I Summary]

Available Devices: Scanlist

>;

EN IO

<

[v' Automap on Add [v Node Active
Upload from Scanner... E;??:Lfcte¥ype
[v Vendor
Download to Scanner... [¥ ProductCode
- [~ Major Revision
Edit /O Parameters. M r

@ 01. TeSysT MMC V0201 R

0K | Cancel I Apply |

Help

4 With the controller selected, click the Edit
1/0 Parameters button.

The Edit I/O Parameters window appears.

Click File > Save to save the global
configuration to the PC.

5 Check Polled and enter 8in the Input Default data sizes are 1 (Input Size) and 1 (Output Size).
Size text field and 6 in the Output Size
text field. Edit /O Parameters : 01, TeSysT MMC V02.01 R - [
Click OK. ] Stobed: ————————————— | ChangeofState / Cyclic. ————
Input Size: 0 3: Bytes @ Chenge © Oyel
v Polled: Output Size: 0 3: Bytes
I Input Size: 8 3: Bytes Heartbeat Rate: (250 = |imece
Output Size: |8l 3: Bytes
Poll Rate: Ewvery Scan v
oK | Cancel | Restare I/0 Sizes |
6 Click Download to scanner. The Downloading Scanlist from Scanner window appears.
7 Click Download. Wait for the Downloading to Scanner timer to finish.
8 Click OK. The scanner properties window closes.
9 Click Offline and select the project path. The global configuration can be saved only offline.

PLC Configuration in Studio 5000

Step Action Result
1 In Studio 5000, select File > New. -
2 Select the type of controller.

B project Types

& Lo Compactlogiv™ 5370 Controlr I
4 Contrllogx® 5570 Contler
1756-L71 ControlLogix® 5570 Controller
1756-L72 ControlLogix® 5570 Controller
w6173 Contrologix® 5570 Contoler
w6174 Contrologix® 5570 Conoler
156175 Contrologix® 5570 Contoler

RSLogix™ Emulate 5000 Controller
SoftLogix™ 5800 Controller

Name:  TesysTDevicenet

Cancel Next

1639575EN-1
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Step Action Result

3 Select the chassis.

1756-L71 ControlLogix® 5570 Controller
TeSysTevicenet

Chassis: (1756-A7 __7-Slot ControlLogix Chassis -
Siot o
Security Authority: (No Protection B

Use only the selected Security Authority for authentication
and authorization

Description:

Redundancy: [ enable

Cancel Back \ Finish

4 Select I/0 configuration. Right-click and
select New Module... ' Logical Model
=-&1/0 Configuration

[=E_J1756 Backplane 1756-A7

fa (0] 1756-|) New Module..
Discover Modules...

B Paste Ctrl+V
Properties Alt+Enter
R En
Print 4

5 Select the Scanner in the list (1756-DNB).
ORIV e e .
Catiog | Module Discovery | Favorias)
T r—
‘reoer S rivare Epami Towms
s ot mmonaptns
o fomieietrea ey
st ottt onaprnt o
ioer odhia st oot s e et
fooreid T o ey it
fowrrid . o C—
e et proteoidif oo
i it protemdiomnd
o e proterill oed
ol o onenrion protersdiivon
e i st B posssilioed
17561AT6 16 Point 79V-132V AC Isolated input AsenBradiey Digtal
1756832 Orgtal
ot pret
17564816 Ogtal
175648160 Ogeal
175648161 y  Digtsl
Close on Creste. Creote | Close. Help.
6 The module properties appear. Select the
input/output sizes in word:
* InpUt size = 8 bytes > two 32'b|t Type: 1756-DNB 1756 DeviceNet Scanner I
words Vendor. Allen-Bradley
. . Name: Scanner Input Size: 2 > (32+bi)
+  Output size = 6 bytes — two 32-bit » i L
words Description: Output Size: b (32-bit)
) . - Status Size (32~ @2
Select the slot (1756-DNB) in the Chassis.
Slot 4 in our example. Node 0 & S

) ] ) Revson (2w 1 [3]  Eectonickeyig
Click Finish to close the configuration.

Open Module Properties oK Cancel Help

7 Select Communication > Recent Path.
Click the appropriate path and select Go
Online.
Go Online
TeSysT_Devicenet ~ AB_ETHIP-1\161.68.154.101\Backplane\0
MCC_TEST AB_ETHIP-1\192.168.1.200\Backplane\0
| Show Only Paths Matching Serial Number in Project ResetPathlist | [ SetProjectPath |
Serial Numberin Project  <none> [ Clear ProjectPath |
Path in Project: <none> :
8 Download the application to the controller. -

34 1639575EN—-1



Quick Start Guide

Motor Management Controller

Step

Action

Result

9

Select Controller Tags to run the scanner,
then set CommandRegister.Run.

9 Lo Onper - TepDevcenet 75671 241 Gl Tgs - TessTomisnetcoron
[ Fle £dt View Search Logic Commemcatons Tools Window Help
0GE & 1@ ) - AAG BN YN @ .8

pan 6168 154 107Backpiane + | (35

AL ==K X =K W e y == g =K == s X
S Do < T e oo
Nome. aic [Vaise [Force Mask_+[Syte [Data Type _[Descrpton
Acww,xmm, [_|* Locatas [ [l 1756 ON8.|
Power Up Hander []- tocatso [ [ | A8 176 0N
T [ = tocata 0 Commanciugmr = (o] Ra e ov|
B MainTask (. Locat4 0 Ce Decenai 800U
i it comangmra e — i
Unschecuied Programs. Locate O Cx I o Decemat  BOOL
i et oomeg e : b —
S rone e H e : =l
Add-On Instructions [ +tocateonm T ] (...[0ecma  ONTR)
3 Data Types [Trtocaes T ol o] A7 o8|
s et
-
o
| Logix Designer - T 756471 -Te
10 Se_lect Controller Tags to see the data 9 Lo e 6 Dntene L G T T
being returned from TeSys T. B5E 8 IRE oo rmian - ARG DA N A4 s -
Pan [ 6168154 101Backplanel” v | (&
Program B2 ¥ ProgramMode = || «
Noras v Rooimwor 080
¥ Energy Storage OK y v s W T Kompws L. W e ]
1] 2 oK )
' oot O = - e
= = S e e
Controlier Fault Handier R 1 [P 1756088
Power-Up Handier ] (S I P 1756 0N,
STasts = LocattiDen T (ool Ceeed[Oocmst  ONTED
B MainTask + Locat41Dataf0) 16443 Decmal ONT
+ “BMainProgram [] *Locate1Dasin) o Decmal ONT
Unscheduled Programs []=tocaten [ ] o] 1756_0N.
s Motion Groups I (e () 175 0N8.
Ungrouped Axes = Locat4 0D T o] (oee)Decmal  |ONTR)
Add-On Instructions. = ) Decmal onT
v s [ teetscoea e
8 User-Defined [+ Locates I ool (el [AB 175 0N
asvos
e v Oeoes

DeviceNet Communication Test

The DeviceNet communication verification sequence is as follows:

Step 1:

Check the communication ok

LEDs on the LTM R front face » End

ok

o

Step 2:

Check the cabling and correct
it if necessary

ok

oL

Step 3:

Check the configuration via
PowerSuite™ or the HMI and
correct it if necessary

1639575EN-1
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Registers for Simplified Operation

Basic setup information using configuration, control and monitoring registers applies to all applications:

Configuration (at start-up)

See commissioning

- el Compulsory circuit
|

------ P Optional circuit

Control
(According to Motor Mode
Register 704)

Bit 704.0: Motor run forward
command

Bit 704.1: Motor run reverse
command

Monitoring (Alarms)

Register 460: Alarm code, or
> Register 461, 462: Alarm type

Monitoring (System status)

(register 455) If an error
has been

Bit 455.2: System tri detected

it 455.2: System trip

Bit 455.3: System alarm ~getmore
Bit 455.8-13: Motor average current | | Information

Monitoring (Trips)

ratio with...
. > Register 450: Trip code, or -
1 Register 451, 452: Trip type
1 Check if the current
I value is correct :
: To be used, if needed, to
v unlock the system v
Monitoring (Measurement) Control (Acknowledgment)
Register 466: Average current ratio Bit 704.3: Trip reset command
Command Variables 700-704
Instance 100: LTM R Control Registers:
Byte 0 ‘ Byte 1 Byte 2 ‘ Byte 3 Byte 4 Byte 5
path 6C : 01: 05 path 6C : 01: 04 path 6C : 01: 01
(Register 704) (Register 703) (Register 700)
LSB (least MSB (most LSB MSB LSB MSB
significant bit) significant bit)

Command variables 700-704 are described below:
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Register DeviceNet Address Variable Type Read / Write Variables
700 6C:01:01 Word Register available to remotely write commands that can be
processed in a specific custom logic
701-703 6C:01:02-6C:01:04 (Reserved)
704 6C:01:05 Word Control register 1

bit 0 Motor run forward command (1)

bit 1 Motor run reverse command (1)

bit 2 (Reserved)

bit 3 Trip reset command

bit 4 (Reserved)

bit 5 Self test command

bit 6 Motor low speed command

bits 7-15 (Reserved)

(1) Even in Overload mode, bits 0 and 1 of register 704 can be used to remotely control LO1 and LO2.

Monitoring Variables 451, 455, 460, 466

Instance 110: LTM R Monitoring Registers (with dynamic configuration)

This assembly contains several monitoring registers commonly used with an LTM

R device. You can choose registers by setting attributes 5-8 of the DeviceNet

interface object:

Byte 0

Byte 1

Byte 2

Byte 3

Byte 4

Byte 5

Byte 6

Byte 7

Register pointed using path C6

Register pointed using path C6:

Register pointed using path C6 :

Register pointed using path C6

:01:05 01:06 01:07 :01:08
(Register 455) (Register 460) (Register 451) (Register 466)
LSB MSB LSB MSB LSB MSB LSB MSB

Monitoring variables 451,

455, 460, and 466 are described below:

1639575EN-1
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Register DeviceNet Address Variable Type Read-only Variables
451 68:01:02 Ulnt Trip code (code of the last trip, or of the trip that takes priority)
455 68:01:06 Word System status register 1

bit 0 System ready

bit 1 System on

bit 2 System trip

bit 3 System alarm

bit 4 System tripped

bit 5 Trip reset authorized

bit 6 Controller power

bit 7 Motor running (with detection of a current, if greater than 10%
FLC)

bits 8-13 Motor average current ratio

32=100 % FLC - 63 =200 % FLC

bit 14 In remote

bit 15 Motor starting (start in progress)
0 = descending current is less than 150 % FLC

1 =ascending current is greater than 10 % FLC

460 68:01:0B Ulnt Alarm code

466 68:01:11 Ulnt Average current ratio (% FLC)
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